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Chapter 1 – Foreword 
The Tutorial 2 - 3Data Expert 10.0: Working with Colors document provides an 
introduction to the basic automatic repair, coloring, and texturing functions 
available with 3Data Expert software for 3D Color Printers. Through this 
sequence, you will learn how to automatically repair, paint, and texture the 
Lamp.wrl model. In the final step, you will output the model for printing with 3D 
color printer.  
This tutorial is the second in a set of two tutorials, each of which covers different 
aspects of model repair, coloring, and print preparation. The following tutorials or 
repair examples are available in the software distribution package through the 
Help > Tutorial Documents command:  

• Expert Series 10.0: Quick Start Guide gives a short introduction to model 
repair and splitting for 3D Printing with 3Data Expert, 3Data Expert Lite 
and Dimensions Expert modules. Estimated completion time 15 minutes. 

• Expert Series 10.0: Tutorial 1 – Working with 3D Models introduces basic 
viewing, measuring, automatic repair, split, connect, hollow, offset, 3D 
Text, Boolean, cut, reduce, surface triangulation and other model 
manipulation functions available for STL files for Additive Manufacturing. 
Applies to All Expert Series modules. Estimated completion time is 3 
hours.  

• 3Data Expert 10.0: Tutorial 2 – Working with Colors introduces basic 
automatic repair and coloring for 3D Color Printer users. For 3Data Expert 
only. Estimated completion time is 60 minutes.  

• Expert Series 10.0: STL and VRML repair examples document includes 
more advanced model repair operations with 3Data Expert. Applies to 
3Data Expert module and partly to 3Data Expert Lite, Dimensions Expert 
and Sim Expert modules. Estimated completion time with 3Data Expert 2 
hours.  

The tutorial documents and the geometry files for the tutorial examples are found 
in the Tutorials folder and its sub-folders (Tutorial 1, Tutorial 2, etc.) in the 3Data 
Expert installation directory.  
The boldface and italics used in this tutorial have designated meanings. A 
boldfaced command is a command or operation that alters the model or is 
otherwise necessary to reach results similar to the example. A statement in italics 
denotes the different parameters and their values; menu commands; mouse 
clicks; file names; Model Tree items; or any new terms introduced to the reader.  
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Chapter 2 – Fixing the Lamp model 
In this example, you will go through the steps required to fix a simple Lamp 
model. The Lamp model is available in VRML format (.wrl) on the 3Data Expert 
installation directory Tutorials/GeomFiles. You will start with a VRML model that 
has no color or textures attached. After completing model repair, painting, and 
texturing, you will save and store the model in ZPR or VRML format for 3D color 
printing.  
Before inputting the model make sure that you have set the correct File Fixing 
settings for 3D Color Printers. The File Fixing settings are set through the Edit > 
Preferences command, as seen below:  

 
 
Now you can  

- input the Lamp model (File > Open) from the Lamp.wrl file.  
You should see the following result on your computer screen: 
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The first 3Data Expert dialog allows you to check and set the units for the 
inputted part. 3Data Expert uses the following default values for different input file 
types:  

● VRML (.wrl, .wrml) files are in meters. 
● STL (.stl) file units are set according to the size of the model, most likely in 

inches. 
● PLY file units are set according to the size of the model, most likely in 

inches.  
● 3DE (.3de) files include the unit information (3DE is a DeskArtes 

proprietary format that allows you to transfer models easily into other 
Expert Series software, including transfer of real surface data along with 
faceted triangle data).   

● ZPR (.zpr) files include the unit information. 
The Choose units for part dialog allows you to set the correct unit if the default 
value is incorrect. The unit will be saved in the 3DE (or ZPR) file when you save 
and store the file.  
The Extents of the part information in the dialog indicates that the Meters setting 
is correct. Press OK to continue. The Operation Mode window will appear: 
 

 
 

Operation Mode 

3Data Expert has four main operation modes: Fix Model, Paint & Texture Model,  
Print Preparation, and View Model mode. The different modes are used for 
different tasks:  
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● Fix Model takes you to automatic model verification and repair, and shows 
shortcuts to the main tools used for repair work.  

● Paint & Texture Model displays the tools for painting and texturing. These 
tools check the model for errors and set it to “What you see is what you 
get” display color mode.  

● Print Preparation shows tools for model manipulation, such as hollowing 
and splitting. These tools also check the model for errors.  

● View Mode allows you to temporarily view the model and then return to 
Operation Mode.  

Now press View Model button to get familiar with the basic viewing commands. 
The Operation Mode window is minimized on the upper right corner of the 
screen. This allows you to return to the Operation Mode window to select another 
mode when necessary: 

 

Basic viewing commands 

Try the following commands to become familiar with viewing operations. Note 
that the commands below do not alter the model’s 3D coordinates. They only 
alter the eye-point location:  

● Rotate the model on the screen by pressing the middle mouse (MMB) and 
moving the cursor. Left mouse button (LMB) rotation is also available most 
of the time except when working with painting, texturing, curve editing, and 
transformations.  

● Rotate the model around a selected surface point by pressing the right 
mouse button (RMB) and moving the cursor. A blue cross indicating the 
rotation middle point appears on the part surface if the cursor is on top of 
the model when the RMB is pressed. 

● Pan the model by dragging with the MMB (or LMB most of the time) while 
pressing the Shift key down.  

● Pan with rubberband by dragging with RMB while pressing the Shift key 
down.  

● Zoom in/out by rotating the mouse wheel. 
● Zoom in/out with MMB (or LMB) while pressing the Ctrl key.  
● Zoom to box with RMB while pressing the Ctrl key. 
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● Hide all by pressing the       icon with LMB (or F5). 
● Show all by pressing the        icon (or F6). 
● Fit the model by pressing the        icon (or F7). 

 
The main viewing command icons reside in the Viewing Toolbar:  

 
Try them out now. For example, turn on the Shaded render mode as seen in the 
image above. Also, set on the 3D Color Printer mode to see the actual model 

colors by pressing down      icon.  
The tooltips provide a short description of each icon (let the cursor remain on top 
of the icon for a couple of seconds to see the tooltip). Please note that some 
icons will perform slightly different operations when is pressed with RMB or LMB: 

 
Also, the Viewing Planes toolbar allows you to select any projection direction as 
the viewing direction (try both LMB and RMB clicks): 

 
During viewing, you will notice that some of the surface areas are white when 
some areas are darker (see the image that follows). The differences in the 
displayed surface colors are due to surface (triangle) normal direction. In the 
white area the triangle normals are pointing towards the viewer and in the gray 
area the inverted normal side of the surface is visible (the normal points into the 
part). One of the tasks in fixing the model is to turn all surface normals to a 
consistent orientation and to align them to point out of the material side of the 
part (to the outside).  
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You can also use the right mouse menu on the display area to show, hide, and 
investigate the model on the screen. Make sure the cursor is on the model while 
pressing the RMB: 
 

 
For example, you can  
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- display the model properties by selecting the Properties 
command:  

 
Object Properties give basic information about the part (e.g., the bounding box or 
the number of triangles). Note that some information (e.g., volume) is incorrect 
because you have not yet repaired the model.   

- Press OK to close the window.  
Now  

- press on the minimized Operation Mode dialog to return to the 
operation mode.  

 

Fixing the Lamp 

The normal way to begin repairing a model is to start with the Fix Model mode. 
To start fixing  

- press the Fix Model button in the Operation Mode dialog now. 

 
3Data Expert will begin automatic model verification (Fix Model > Verify Shells 
command). The screen is erased and a progress toolbar appears. When the 
analysis is ready, a Model status message box displays:  
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The message indicates that there are 27 verified shells, of which three shells 
contain errors. The display also shows red Gap curves through the surfaces. 
Gaps are an error type you must fix during the repair process. Note that the 
model is now displayed completely in white. This color indicates that the normals 
are already oriented consistently and correctly outwards.  
The model is divided into separate shells during verification. In the case of this 
Lamp, shells include the shade, bolts, and different joints.  

- Press the OK button in the Model status dialog to see the full model 
structure with different shells in the Model Tree (on the left-hand side 
of the image that follows).  

The error shells have red icons and the correct shells have green icons in the 
Model Tree. The Fix Model Tab on the Tools Window (on the right-hand side) 
provides shortcuts to the commands available for repair. The Help text window at 
the lower part of the Fix Model Tab also contains information for repair actions.  
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You are now in the middle of the automatic verification and repair process. 3Data 
Expert now asks if you wish to continue with Auto Repair:  

 
Auto Repair is the best path to follow when repairing everyday models so  

- press the Yes button to initiate Auto Repair.  
Auto Repair will attempt to fix all shells with errors in the Model Tree.  
 

Auto Repair 

When Auto Repair is started each shell is run through the automatic repair 
command (Fix Model > Repair Shells command) using automatically calculated 
parameters. For each shell, a progress bar shows the progress of the repair (and 
this may cause some flickering on the screen when shells with only a few 
triangles are repaired). You will then receive the following message:  
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This indicates the model is fully repaired and ready to output for printing. After  

- pressing the OK button, you will receive a prompt for the Repair color 
mode: 

 
- Press the No button because there are no errors to fix anymore and 

to continue on with model painting and texturing. 
In Repair color mode the model is displayed with colors beneficial to repair work 
(pink outer surface, red error triangles, etc.) and in the 3D Printer color mode 
(“What you see is what you get”) the model is displayed as it will show when 
printed with 3D Printer color (the Color Display Mode can be changed by 
pressing the        icon).   
You will now receive the final status report.  

- Press the OK button to close the Model status window,  
containing the final status report, after Auto Repair.  
A Tip Window with useful tips on viewing and selection mechanisms is also 
displayed after Auto Repair: 
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You can just Close or Minimize the Tip Window and the “Introduction to File 
Fixing” page for later reference during the repair session. You can also 
permanently turn off these windows when you become more familiar with the use 
of the repair tools in 3Data Expert through the Show Command Tips and Don't 
show the window after Auto Repair settings in the dialogs. You can restart both 
windows through the Help menu.  
During Auto Repair, 3Data Expert attempts to fill all gaps and remove non-
manifold triangles (overlapping triangles, multiedge triangles, duplicate triangles, 
triangles having less than three neighbors, etc.) from the model (to see more 
about triangle errors, please access the “Triangle errors” page in the Online Help 
chapter “Handling Faceted Models”). The Lamp model only has simple errors, 
like inverted triangles and gaps, which are all fully repaired during the Auto 
Repair process. You can now continue on to painting and texturing the model.  
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Chapter 3 – Coloring the Lamp model 

You should now have the fully repaired Lamp available (if not you can input the 
Lamp-repaired.zpr file from the Tutorials/Tutorial 2 – Working with Colors 
directory in the 3Data Expert installation). To start coloring the model you will use 
the tools in the Paint and Texture mode. Paint and Texture mode is activated by 
opening the Paint & Texture Tab in the Tools Window.  

- Press the Paint & Texture Tab now (green circle below):  

 
This will open the Paint & Texture Tab with the shortcuts to the tools for painting 
and texturing. The lower most window provides Help text on different operations, 
including Painting, Texturing, and Edge line editing. You can always refer to the 
Help text to find the correct operation and mouse/keyboard sequences (please 
see the image that follows). 
The Model Tree Window closes because it is not required for model coloring (you 
can hide/show the Model Tree with the F8 key at any time, the Tools Window 
with Shift+F8 key). The window layout should now look as follows: the Tools 
Window with the Paint & Texture Tab on top displays on the right-hand side:  
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If the Repair color mode was previously set, the color mode should be set to 3D 
Printer color mode now (you should press the Yes button if the dialog below 
appears):  
 

 
 

Selecting shells, surfaces, and triangles 

During model coloring, you will select target objects (whole model, individual 
shells or surfaces, and triangles) to color from the display area. The selection is 
done with the left mouse button (LMB), and the selection target is controlled by 
the Selection mode buttons in the Paint & Texture Tab:  
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The four Selection mode buttons refer to selecting the whole model, one shell, 
one surface, or one triangle. Now try to select a shell from the display area, such 
as the Lamp cover. The Selection mode is on Shell selection by default but if not  

- press the    

 
button to turn on the Shell selection. Then  

- click with the LMB on the Lamp cover: 

 
 
You have now selected the lamp cover, which is a separate shell (if you do not 
see the green selection box make sure that the show bounding box is turned on 
with the   icon).  
 
Now try to select a surface in the shade shell. First  

- press the  
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button to turn on the Surface selection mode. Then  

- select the inner surface from the Lamp cover by clicking with the 
LMB:  

 
 
The inner surface of the shade is selected in the image above and also displayed 
in wireframe mode for clearer visibility of the selection (for wireframe display of 
the selected surface press wireframe        icon with RMB ). 
Now  

- press the part selection 

button to select the full part and then press the shaded        icon with the LMB to 
restore shaded color to the whole model.  
You can now  

- press the F8 key to display the Model Tree Window again.  
All previous selections (whole model, shell, and surface) have a corresponding 
node in the Model Tree. The Model Tree root All should be selected in this 
instance (i.e., the whole model): 
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The Model Tree contains the full breakdown of the repaired Lamp model: whole 
model (All), shells (1. Lamp (Repaired), 2. Lamp (Repaired), etc.) and surfaces 
making a shell (1. Repaired, 2. Repaired, etc.).  You can select objects freely in 
the Model Tree with the left mouse button (LMB), you can open/close shell nodes 
by pressing the +/- icons and you can use the RMB menu to display, hide, and 
investigate objects in the Model Tree:  

 
Now retry the different graphical Selection modes (shell, surface, and part) and 
see how the selection changes in the Model Tree when corresponding objects 
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are selected from the display area. For example, when hiding shells in the Model 
Tree they disappear from the display area and their icon turns gray.  

- Press F8 to close the Model Tree when finished and  
- turn the Part selection mode on to select the full part again.   

 

Painting the Lamp 

Now you know how to select objects for painting. Your next task is to add new 
colors and textures to the Lamp. You will start by giving a light-blue coloring to 
the Lamp frame.  

- Turn the Part selection mode on first and  
- set the light-blue color as the Foreground color (click with RMB on 

the circled Foreground color button and select the color with a 
standard Windows color palette): 

 
Then  

- press the Paint  

 
button on the Paint & Texture Tab to color the whole part with the light-blue color 
(shown in the left-hand image below). Now  

- turn on the Shell selection mode and  
- set the green Foreground color: 

 
- Press the Paint button in the Paint & Texture Tab again and  

 
- select the joints in the steel frame and the base with the LMB.  

Every time you select a shell, it is painted with green color. When ready  
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- press the RMB on the display area to finish the Paint command for 
shells.  

If you selected the wrong shell, you can press the ESC key to undo the last shell 
painting. Your lamp should now have the following appearance (right-hand 
image):  
 

  

 
Now also  

- paint the light bulb yellow and the inner cover surface (in Surface 
selection mode) to grayish-yellow 

 
 
to set the color for the inner side of the cover:  
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Now paint a few triangles in the bulb red to provide the final touch.  

- Turn the Triangle selection mode on and select the red Foreground 
color.  

 
Then  

- Press the Paint command 

 
button and  

- select individual triangles from the screen with the LMB.  
Each triangle immediately changes to red. If the wrong triangle is selected, press 
the ESC key to undo triangle painting. When you are  

- ready press the RMB to accept and finish painting triangles.  
The result should look similar to the result on the image that follows.  
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Editing edge lines 

During model verification and repair, shells are divided into surfaces. Sometimes 
these surfaces are insufficient for correct coloring or texturing of the model. In a 
case such as this, use the Edge lines commands to show, add, delete, and 
sketch new edge lines on shells. The main purpose for editing edge lines is to 
define new surface areas on the model for accurate texturing and painting.  
To see the surface edges you must  

- turn on Show edge lines in the Edge lines group:  

 
The edge lines are always displayed for the selected object (i.e., the whole 
model, shell, or surface). Now try to  

- select the whole model (Part selection mode) and then  
- a small knob shell (Shell selection mode) in the frame.  

The orange edge lines appear according to the selection (see the image that 
follows).  
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Any edge line editing command (add, remove, split, or merge) operates on a 
single shell until you end the command with a RMB click. The shell to operate is 
set when you pick the first edge from the displayed shells. After completing an 
Edge line command and before starting a new command, you need to select the 
shell to operate again (this can be the same shell as the previous shell).  
Now imagine you want a red area on the small knob (seen on the right-hand 
image above).  

- Select the shell (if not already selected) and  
- Fit it on the display area by pressing the       icon with a RMB.  

It also may be a good idea to show the model in Shaded and wireframe mode by  
- pressing the Shaded+wireframe         icon  

to see the individual triangles more clearly.  
You can first investigate the length of the different surface edge lines with the 
Pick edge line command.  

- Press the Pick edge line  

 
button and then  

- pick the orange edge lines displayed on the image below:  
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The picked edge lines are shown in yellow. Practice picking different edge lines 
and you will see that edge lines always end (after Auto Repair) at an intersection 
where more than two edge lines meet.  

- When ready press the RMB to quit the edge-line picking.  
Any set of connected edge lines with no internal edges define a surface in the 
shell. The edge lines can be separate (i.e., not merged) but must have common 
end points to close the loop defining a surface area. 
Now you are ready to delete a few edge lines.  

- Give the Delete edge lines command by pressing the Delete edge 
lines 

 
button.  

- Pick the edge lines with the LMB on the narrow side of the knob.  
They are immediately deleted (do similar deletions on the other side of the shell).  

- Press the RMB when ready or the ESC key to cancel an unintended 
deletion.  

The result should look like the left-hand image below:  
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After deleting the necessary edges, you can  

- add new edges by pressing the Add edge line 

 
button and then  

- carefully picking triangle edges that provide the correct starting 
direction for the added edge.  

When a triangle edge is picked the edge line is extended until another edge line 
is crossed, following the most probable sequence of triangle edges. For example, 
you can create the correct edge line (yellow when picked) shown on the right-
hand image by single picking on the triangle edge circled in red. When ready to 
pick new edges  

- press the RMB to accept the new edges or the ESC key to cancel 
one edge at a time.  

When the RMB is pressed, new surfaces are created (also in the Model Tree).  
After creating a new surface, you can paint or texture it as a single entity. In the 
image below the new surface is painted with red:  
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You can now  

- turn off the Show Edge lines and  
- turn on the Shaded display mode         .    

 

Texturing with chessboard bitmap 

Texturing allows you to add images in different formats (.bmp, .gif, .jpg, .pcx, 
.png, .ras, .pic, .tga, and .tif) on top of faceted models. For example, you can use 
a cloth texture to make a garment look more realistic or you can add a text 
annotation to provide information on the required manufacturing tolerances.  
The texturing commands are accessed through the Painting and annotating 
group in the Paint & Texture Tab:   

 
Now you will add three textures to the Lamp model: a cylindrical chessboard 
texture around the lamp cover, an engineering template on the bottom of the 
part, and a drawn circle on the model.  
To add the chessboard texture first  

- select the Lamp cover from the screen in the Shell selection mode,  
- fit it in the display area (       + RMB), and view it from the X axis 

direction (press         icon): 
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Begin texture addition by  

- pressing the Add texture  

 
button which generates a File Open window so you can browse for the texture 
image file. The texture open dialog includes a preview window for the image files 
on the right-hand side of the window. This helps you to select the correct image 
for the texturing command easily.  
Now you will  

- select the chessboard.bmp in the Tutorial/Tutorial 2 – Working with 
Colors  directory.  

- Press OK to input the image.  
Soon you will see the Lamp and the image in front of the lamp on the display 
area. The image may appear smaller or bigger than in the image below when 
compared to the lamp, we will soon scale it to correct size.  



3Data Expert 10.0: Tutorial 2 - Working with Colors 

 - 29 -     

 

In this case, you want to generate a cylindrical projection around the cylindrical 
lamp cover.  

- First, you will scale the chessboard image to the correct size on 
top of the cover.  

Immediately after inputting the image, the Help text window displays detailed 
information on how to zoom, pan, and rotate the image and the model.  
Image transformations are performed by the following commands using the left 
mouse button (LMB):  

● Move image: left mouse button (LMB) 
● Scale image: Ctrl+LMB 
● Rotate image: Ctrl+Shift+LMB 

● You can also use Arrow keys (with the same modifiers) 
You can rotate, pan, or zoom the model with the same modifiers using the 
middle mouse button (MMB).  
Using the above commands to position the image on top of the model as shown 
in the image below:  
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In this case, you want to position the image only on the outer surface of the Lamp 
cover. First,  

- turn on the Surface selection mode 

 
and then proceed to selecting the correct surface after  

- pressing the select target  

 
button in the Paint & Texture Tab. Then  

- click on the cover with the LMB to select the outer surface for the 
texturing operation (the surface edge lines are highlighted in yellow) 
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You can select any number of surfaces or shells for texturing but here you will 
work with the single selected cylindrical surface. If you select the wrong surfaces, 
press the ESC key to cancel the last selection.  
You want to generate a cylindrical texturing for this model using Advanced 
options in the Painting and annotating group.  

- Press Advanced options and fill in the parameters below:  

 
 
Now  

- press the Preview  

 
button (or RMB) to see how the textures fit on the model. If you are not satisfied 
with the preview results, you can press the ESC key to cancel the previous 
operations one by one. If you are satisfied,  
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- press the Accept texturing  

 
button (or RMB again) to see the final texturing on the model. After selecting the 
textures surface, the final texturing for the cover should look like the example 
below: 

 
After clicking the RMB button, a larger selection box displays because the whole 
model is selected, although not yet displayed, after accepting a texture.  
 

Adding an engineering template 

Applying an Engineering template (and Text) represents a special case of the 
normal image texture operation described above. With normal texture addition, 
the texture image is read from the image file. With an engineering template, the 
image is first generated with the HTML editor that is built into the software.  

- Start by taking a view from the Lamp model bottom (-Y axis 
direction, 

          icon + RMB, make sure the Show Edge lines is turned on): 
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Then  

- press the Apply Engineering template 

 
button. This opens the HTML Editor for inputting text into predefined fields in the 
template: 
 

 
 
When done editing the text  
press the OK       icon.  
Now you will see a texture image in front of the model as you did with the 
previous exercise using the chessboard image.  

- Use the pan, rotate and zoom commands (see Help Text) to position 
the texture correctly on top of the model, as shown below: 
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- Pick the surface to add the texture (in Surface selection mode): 

 
After  

- pressing the Preview and Accept buttons, you should see the 
following result on the screen when all is displayed: 
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User-defined engineering templates in HTML format provide ultimate flexibility 
and can be loaded by pressing the Open      icon in the HTML editor. You can 
also generate a basic table template by pressing the Insert Table        icon. 
 

Draw circle on surface 

Drawing a circle (or arrow) on a surface is once again a special case of the 
normal texture addition (see the chessboard example). To apply a circle the 
circle (arrow) is first drawn on the model. When ready the normal image texture 
commands apply to the positioning, surface picking, previewing, and completion 
of adding the texture on the part.  
Now you will add a circle on the back side of the Lamp cover. First,  

- take a view from the Z axis direction (         icon and LBM, Show 
Edge lines turned off): 
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Then  
- set the Selection mode and Foreground color as shown in the 

image below:  
 

 
Now  

- press the Apply Circle  

 
button. You can now  

- draw the circle on the back side of the cover and position it in the 
middle near the top by dragging with the LMB: 

 

 
You do not need to place the circle in the exact location immediately; only the 
size and the thickness matter at this stage. You can change the Line width 
through the Advanced options if it is not correct already. The Advanced button 
must be pressed separately to invoke the options dialog:  
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After the parameters are set, you can position the circle correctly (Shift+LMB) 
and then 

- select the surface as seen in the image that follows: 

 
Now  

- press the Preview and Accept buttons to add the circle texture to 
the model (the result appears in the left-hand image below):  
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The Lamp-colored.zpr file represents the final result. 
 

Saving the file  

When saving the file to VRML or ZPR format with the File > Save As command 
you must take some care. The final model contains several shells (27) that can 
all be outputted separately without making the whole model. The best practice is 
to display the Model Tree (F8 key) and select the whole model first, (i.e., the 
Model Tree root All). When All is selected, every shell will be written to the output 
file. If something other than the All root is selected a warning is issued before the 
file is written. 
If the model is to be outputted to some other than 3D Color Printer you must 
check that the receiving system will accept multi shell parts (= parts made of 
several shells intersecting in 3D space). If not, please use the Modify Faceted > 
Boolean and Boolean Multiple commands to connect the separate shells into a 
singe shell before outputting the part.  
 

Transferring directly to 3D Printer  

If your PC has some 3D Printer control software installed, you can most likely 
create a direct connection to it. Print Preparation > New Plugin command allows 
you to create direct links to third party software products. Please see the Online 
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Help page Menus and Commands / Print Preparation / New Plugin page form 
more info.  
 

Chapter 4 – Conclusions 
Congratulations for reaching the end of this tutorial! The process and commands 
you have just learned will help you through the automatic repair needed for the 
majority of 3D models with 3D Color Printers. Also, you are now familiar with 
most of the coloring and texturing commands. For more information on texturing 
and painting, please see the “Color and Texture menu” Help pages in the Online 
Help “Menus and Commands” chapter.  
3Data Expert is part of the DeskArtes Expert Series software suite. To learn 
more about the capabilities of other Expert Series software for 3D data fixing, 
coloring, preparation, or 3D model generation, visit www.deskartes.com:  

● 3Data Expert for full model repair and manipulation, including 2D 
Dimensioning, texturing and coloring, triangle reduction and refining, 
support generation, model slicing, etc.  

● Dimensions Expert for basic file repair, splitting, connecting and 
dimensioning.  

● 3Data Expert Lite adds 3D Text generation and Boolean operations to add 
3D Text to your parts.  

● Sim Expert includes special set of tools for reducing triangle count and to 
improve triangle aspect ratio for simulation applications. 

● Import Package for importing native surface models from 
Pro/ENGINEER®, Unigraphics®, and Catia® 3D CAD systems, and STEP 
files for 3D Printing. 

● Design Expert for generating your own free-form 3D geometries with an 
easy-to-use and powerful 3D CAD system.  

● View Expert for easy 3D model viewing, verification and measuring.  
● ZEdit Pro for 3D System 3D Printers  

 
 

http://www.deskartes.com/
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